T.92 USB
DIRECT DRIVE TURNTABLE

USER MANUAL
1. Read Instructions – All the safety and operating instructions should be read before this product is operated.

2. Retain Instructions – The safety and operating instructions should be retained for future reference.

3. Heed Warnings – All warnings on the appliance and in the operating instructions should be adhered to.

4. Follow Instructions – All operating and use instructions should be followed.

5. Water and Moisture – The appliance should not be used near water - for example, near a bathtub, washbowl, kitchen sink, laundry tub, in a wet basement, or near a swimming pool, and the like.

6. Wall or Ceiling Mounting – The product should be mounted to a wall or ceiling only as recommended by the manufacturer.

7. Heat – Appliance should be situated away from heat sources such as radiators, heat registers, stoves, or other appliances (including amplifiers) that produce heat.

8. Power Sources – This product should be operated only from the type of power source indicated on the rating label. If you are not sure of the type of power supply to your home, consult your product dealer or local power company. For products intended to operate from battery power, or other sources, refer the operating instructions.

9. Grounding or Polarization – This product may be equipped with a polarized alternating-current line plug (a plug having one blade wider than the other). This plug will fit into the power outlet only one way. This is a safety feature. If you are unable to insert the plug fully into the outlet, try reversing the plug. If the plug should still fail to fit, contact your electrician to replace your obsolete outlet. Do not defeat the safety purpose of the polarized plug.

10. Power-Cord Protection – Power-supply cords should be routed so that they are not likely to be walked on or pinched by items placed upon or against them, paying particular attention to the cord in correspondence of plugs, convenience receptacles, and the point where they exit from the appliance.

11. Cleaning - The appliance should be cleaned only as recommended by the manufacturer. Clean by wiping with a cloth slightly damp with water. Avoid getting water inside the appliance.

12. Non-use Periods – The power cord of the appliance should be unplugged from the outlet when left unused for a long period of time.

13. Object and Liquid Entry – Care should be taken so that objects do not fall and liquids are not spilled into the enclosure through openings.

14. Damage Requiring Service – The appliance should be serviced by qualified service personnel when:

   A. The power-supply cord or the plug has been damaged; or
   B. Objects have fallen, or liquid has been spilled into the appliance; or
   C. The appliance has been exposed to rain; or
   D. The appliance does not appear to operate normally or exhibits a marked change in performance; or
   E. The appliance has been damaged, or the enclosure damage.

15. Servicing – The user should not attempt any service to the appliance beyond that described in the operating instructions. All other servicing should be referred to qualified service personnel.

16. Ventilation – Slots and openings in the cabinet are provided for ventilation and to ensure reliable operation of the product and to protect it from overheating, and these openings must not be blocked or covered. The openings should never be blocked by placing the product on a bed, sofa, rug, or other similar surface. This product should not be placed in a built-in installation such as a bookcase or rack unless proper ventilation is the manufacturer’s instructions have been adhered to.

17. Attachments – do not use attachments not recommended by the product manufacturer as they may cause hazards.

18. Accessories – Do not place this product on an unstable cart, stand, tripod, bracket, or table. The product may fall, causing serious injury to a child or adult, and serious damage to the product. Use only with a cart, stand, tripod, bracket, or table recommended by the manufacturer, or sold with the product. Any mounting of the product should follow the manufacturer’s instructions, and should use mounting accessory recommended by the manufacturer.

19. Lightning – For added protection for this product during a lightning storm, or when it is left unattended and unused for long periods of time, unplug it from the wall outlet and disconnect the antenna or cable system. This will prevent damage to the product due to lightning and power-line surges.

20. Replacement Parts – When replacement parts are required, be sure the service technician has used replacement parts specified by the manufacturer or have the same characteristics as the original part. Unauthorized substitutions may result in fire, electric shock, or other hazards.

21. Safety Check – Upon completion of any service or repairs to this product, ask the service technician to perform safety checks to determine that the product is in proper operating condition.

22. This product is in compliance with EUWEEE regulations. Disposal of end of life product should not be treated as municipal waste. Please refer to your local regulations for instructions on proper disposal of this product.

23. Carts and Stands – The appliance should only be used with a cart or stand that is recommended by the manufacturer. An appliance and cart combination should be moved with care. Quick stops, excessive force, and uneven surfaces may cause the appliance and cart combination to overturn.

24. WARNING: The mains plug is used as disconnect device, the disconnect device shall remain readily operable.

25. This equipment is a Class II or double insulated electrical appliance. It has been designed in such a way that it does not require a safety connection to electrical earth.
Thank you for purchasing the T.92 USB turntable from Stanton. The T.92 USB has been designed to allow easy transfer of vinyl records to CD or MP3. The T.92 USB is built upon Stanton’s heritage of designing audiophile products for the most discriminating listener. Before assembling the T.92 USB please check to make sure the following items are included with the main unit in the carton.

- Cakewalk Pyro Installation CD
- AC cord
- RCA cable
- USB cable
- 45 rpm adaptor
- Counter weight
- Platter
- Slipmat
- Cloth dust cover
- Instruction manual
- Stanton 500.V3 Cartridge pre-mounted on headshell

After confirming that all of the above parts are included in the box, it’s time to assemble the turntable.

1) Remove the platter from its protective wrapping and place on the spindle of the main unit.
2) Remove the slipmat from its protective wrapping and place on the platter.
3) Place the counter-weight on the back of the tonearm assembly.

1. Connect the power cord to an AC outlet.
2. Connect the RCA cable to the PHONO input of your mixer. You can also use a line input by setting the phono/line switch at the rear of the turntable to Line.

Visit www.stantondj.com for downloadable updates, videos, and news about this product.
The major cause of problems in sound and skipping on the vinyl is the lack of proper set up of the needle and turntable adjustments. The needle is designed to operate at a specific angle to the vinyl. The T.92 USB has several adjustments to correctly position the needle to the vinyl.

1. The first adjustment is the installation of the cartridge-head-shell assembly into the tone arm tube lock. The T.92 USB includes a Stanton 500 V3 cartridge pre-mounted to the headshell. Holding the tone arm tube in one hand, insert the cartridge-headshell into the tube lock with the other hand. Turn the lock ring clockwise (when viewed from the rear) until the headshell is locked tightly into the tone arm. Remove the needle protector from the cartridge and place the needle on record. View the needle from the front and insure that the needle is perpendicular to the record surface. If some adjustment is needed, simply loosen the lock ring and rotate the cartridge headshell until the needle is perpendicular to the record surface. Then re-tighten the lock ring.

2. The second adjustment is the needle (or stylus) pressure. Start with the cartridge headshell assembly mounted into the tone arm. Remove any needle protectors provided. With tone arm free, adjust the tone arm counterweight by rotating the rear section until the tone arm floats in a balanced condition above the record or mat. Do not allow the needle to drop onto the mat or the turntable platter during this adjustment. You might damage the needle tip. Now, carefully hold the tone arm in one hand while rotating the numbered ring on the front of the counter-weight with the other hand to the “0” setting. Next, without touching the numbered ring, rotate the rear counterweight until the desired needle pressure reading is next to the line on top of the tone arm tube. The recommended stylus pressure for the Stanton 500 V3 cartridge is between two and five grams.

3. The third adjustment is to set the anti-skating. If you are using the turntable/cartridge for playback purposes you will need to set anti-skating. Anti-skating helps keep the needle centered in groove during standard playback. However anti-skate will actually cause the needle to skip if used while scratching or back cueing. To set anti-skating for playback simply turn the anti-skate dial to the same number setting as the stylus pressure reading (ex: 1 gram of stylus pressure = 1 gram anti-skate). If you are scratching leave the anti-skating to “0”.
1. **REVERSE** - This button is used to reverse the direction of the platter rotation.

2. **START/STOP** - Press this button to start or stop the platter.

3. **STROBE DOTS** - The dots around the edge of the platter are used in conjunction with the light located inside the motor ON/OFF switch. While the platter is in rotation, the dots help to indicate the speed of rotation. The speed is lower than the displayed speed (33, 45, 78) when the dots are flowing to the right. It is higher than the displayed speed (33, 45, 78) when the dots are flowing to the left. When the strobe is stopped, the platter is rotating at the displayed speed.

4. **SLIP MAT**

5. **CENTER SPINDLE** - This spindle holds the turntable PLATTER record stable and centered.

6. **MOTOR ON/OFF SWITCH** - As opposed to fully analog turntables, this is not the power switch. This switch only turns the motor on or off. Rotate clockwise to turn on the motor. The platter will not start spinning until the start/stop button has been pressed. Rotate counterclockwise during playback (off position) for a slow winding down effect.

7. **PLATTER SPEED BUTTONS (rpm)**
   - 33 rpm – Press 33
   - 45 rpm – Press 45
   - 78 rpm – Press the 33 and 45 buttons simultaneously.
   - To return to 33 or 45-rpm play mode, just press the desired button.

8. **HEADSHELL** - Install the cartridge here per the “Tonearm and Cartridge Settings” section of this manual.

9. **KEY LOCK** - Press to enable key lock. When KEY LOCK is on, the pitch slider will only affect the speed of the platter. The key (pitch) will remain fixed. This speeds up the musical tempo without changing the pitch.

10. **HEADSHELL LOCKING NUT** - Attach the headshell by inserting into the front end of the tone arm. Turn the locking nut clockwise with the head shell firmly held horizontally.

11. **PITCH ON/OFF INDICATOR** - When this indicator is illuminated the speed of the platter is locked in either 33 1/3, 45, or 78RPM via the quartz lock feature depending on which RPM the PLATTER SPEED BUTTONS are set to.

12. **PITCH SLIDER** - This slider is used to speed up or slow down the turntable platter. Pitch speed is often changed in DJing to match corresponding tempo’s of two records.

13. **TONE ARM** - This is a fully manual tone arm. To start playback, gently place the stylus on the record using the headshell finger support. Do not drop the stylus onto the record as it may cause damage to the diamond tip and to the record.

14. **PITCH SELECT** - Press the button to select between +/-8% and +/-12% pitch range.

15. **TONE ARM CLAMP AND REST** - Use this rest for the tone arm and clamp it in position during transportation.
16. ANTI SKATE KNOB - When a record is playing, a centrifugal force is generated drawing the stylus towards the center of the record. This control compensates for that force and needs to be set to the same value as the counter weight pressure ring. See “Tonearm and Cartridge Settings” instructions for more information.

17. TONE ARM BASE - The tone arm base includes tone arm rest.

18. COUNTERWEIGHT - Use this to balance the tone arm and to adjust the stylus pressure. See “Tone Arm And Cartridge Settings” for proper adjustments.

19. 45-RPM ADAPTOR HOLDER - Place the attached 45-rpm adaptor here. Push down the rear side of 45 rpm adaptor to take it off.

20. EXTRA HEADSHELL HOLDER - Place extra headshell here.

21. PHONO/LINE OUTPUT L & R - This is the standard analog output (RCA jacks) which can be connected either to a phono or line input on any DJ mixer or stereo system, depending on the setting of the phono / line selector.

22. PHONO/LINE SWITCH - Switches the output to either phono or line level. Use the PHONO setting when plugging into a “PHONO” input on a receiver or DJ mixer. Use “LINE” position when connecting to a line level input such as CD or VCR on a receiver.

   WARNING – Never connect a line level output (LINE position) to a PHONO input on a receiver or DJ mixer.

23. USB SOCKET- Connect the USB cable (included) to this socket and to a USB connector on your computer. After connecting the turntable to your computer, you can record your vinyl to your hard disk using the included Cakewalk Pyro software. For recording instructions please follow the instructions outlined in “Cakewalk Pyro Audio Creator LE Overview” section of this manual.

   Note: maximum USB cable length is 3m

24. DIGITAL OUTPUT - Use this output to connect your T.92 USB to the S/PDIF digital input of any equipped digital device, such as a CDR or computer soundcard.

25. POWER CORD CONNECTOR - Used to connect the included power cord.

26. POWER SWITCH - This switch turns the power on or off, including the motor and audio signal. Use this switch when the unit will not be active for extended periods of time.
The T.92 USB includes a USB computer interface and Cakewalk Pyro Audio Creator LE CD software for Windows. Macintosh users can download the free Audacity software for recording directly from the T.92 USB. By connecting the T.92 USB to your computer and using the correct software, you can create custom CDs from your record albums.

In addition to creating CDs, you can edit the LP tracks, clean up clicks and noise, and apply special audio effects if desired. You can even make custom mixes with one track crossfading to another. To take full advantage of these features, be sure to read the User Manual or Help files in the software.

Audacity is free software, licensed under the GNU General Public License (GPL). More information as well as open source code can be found on the web at http://audacity.sourceforge.net/

* Please ensure you have installed the software before starting.

SET UP PROCEDURE

1. Start by connecting your T.92 USB to the computer using a USB cable (included).
2. Download and install the Audacity recording software by visiting http://audacity.sourceforge.net/
3. Open the Audacity program.
4. Go to EDIT then PREFERENCES.
5. Click AUDIO I/O tab.

6. Choose recording device USB AUDIO CODEC from the drop down menu.
7. Choose CHANNELS (2 STEREO).
8. Tick SOFTWARE PLAY THROUGH BOX.
9. Click OK. .
10. When you are ready to record, click the **RED** record button on the computer. Play the LP track to be recorded.

11. When you have finished the recording, click the **YELLOW** stop button. Click the **GREEN** play button to playback your finished recording.

   You can now click **FILE** and choose **Export As AIFF** (Macintosh) or **Wave** (Windows) to save the recording. This will save the entire recording as one audio file.

12. If you want to record the entire side of an LP, or a continuous selection of songs, repeat steps 1-3 above. When you are finished, you will be able to see each song as a waveform, with silence in-between each song. If you stop the recording and then start again, the new recording will appear as new audio tracks below the previous recording.

   If you want to separate the recorded audio into different tracks, drag the cursor over a song segment in the waveform window to highlight it, and then from the **FILE** menu select **Export Selection As AIFF** (Macintosh) or Wave (Windows). If you want to save it as an MP3 file, then choose **Export Selection As MP3**. Give the file a name when prompted. Repeat for each song segment.

13. You can remove silences at the start or end of the recording by dragging the cursor over the silent region and then choosing DELETE or CUT from the Edit window.

14. For a Macintosh, after you have recorded your tracks, burn them to a CD using the Mac OSX Finder, or with other Macintosh CD creation programs. For Windows, use Windows Explorer or another Windows CD creation program to burn a CD.
CAKEWALK PYRO AUDIO CREATOR LE OVERVIEW (PC users)

The T.92 USB comes with a complimentary CD with Cakewalk Pyro Audio Creator LE. Cakewalk Pyro Audio Creator LE allows you to create CD's directly from audio recorded from the T.92 USB to a Windows-based PC. The system requirements for Pyro Audio Creator LE are below.

<table>
<thead>
<tr>
<th>System</th>
<th>Requirements</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating System</td>
<td>Windows XP</td>
<td>Windows XP/Vista/Vista x64</td>
<td></td>
</tr>
<tr>
<td>Processor Speed</td>
<td>Intel® Pentium® 4 1.3 GHz, or AMD Athlon™ XP 1500+ or higher</td>
<td>Intel® Pentium® 4 2.8 GHz [EM64T] or AMD Athlon™ 64 2800+ or higher</td>
<td></td>
</tr>
<tr>
<td>RAM</td>
<td>256 MB</td>
<td>1 GB or higher</td>
<td></td>
</tr>
<tr>
<td>Hard Disk Space</td>
<td>50 MB for core program</td>
<td>1 GB for program and content</td>
<td></td>
</tr>
<tr>
<td>Video resolution</td>
<td>1024 X 768, 16-bit color</td>
<td>1280 X 960, 32-bit color</td>
<td></td>
</tr>
<tr>
<td>Hard Disk Type</td>
<td>Any</td>
<td>EIDE / Ultra DMA (7200 RPM) or SATA</td>
<td></td>
</tr>
<tr>
<td>Audio Interface**</td>
<td>Windows-compatible</td>
<td>WDM- or ASIO-compatible, including Wave RT for Vista</td>
<td></td>
</tr>
<tr>
<td>Optical Drive***</td>
<td>CD-ROM required for installation / CD-R or CD-RW capability required for CD audio disc burning</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To start, insert your complimentary Cakewalk Pyro Audio Creator LE CD into your disc drive on your computer and follow the installation instructions to completely install the software on your operating system. Complete instructions on how to use all the features of the software are included in the Help Menu. To transfer and record LPs to your hard drive from your T.92 USB, start by connecting your T.92 USB to your computer using the included USB cable.

Launch the Cakewalk Pyro Audio Creator LE application via the start menu. The Audio Creator Toolbar will now be available for use.

1. Click the Options button at the top of the toolbar. This will allow you to select the T.92 USB as the USB audio input. This will bring up the screen shown below.

   ![Audio Options - MME (32-Bit)](image)

   For Playback Device, select your soundcard. For Recording Device, select:
   Stereo USB Audio CODEC.- After selecting this output you may monitor the recording via the RCA output on the T.92 USB.

   The sampling rate for CD's is 44,100 Hz, so it is best to choose this rate in the Sample Rate selection. The Driver Mode menu is used to select the driver (ASIO, MME or WDM) that you are using for your soundcard, (for the T.92 USB, "MME (32-Bit) is suggested). Latency refers to how fast the software responds to commands. Higher latency values are safer when recording and playing back audio. If audio clicks or pops are heard when recording or playing back recordings, it is suggested to raise this setting. When you have completed choosing your settings, press OK to close the Options Window. These settings will be saved and should not need to be edited again.
RECORDING AUDIO FROM A RECORD

2. Press the EDITOR button on the toolbar to bring up the editing window. This is where you will record and edit your audio files. After pressing the EDITOR button, the screen below will appear.

3. Press the (3) Input Monitoring button. This will allow you to listen to the audio as you record it from the T.92 USB.

4. Press the red (4) Record button. This will also light up the (5) Pause button. Play a record on your turntable and you will see the meters at the right of window show you the recording level. Now you are ready to record your record album.

5. Press the Pause button and Audio Creator will start recording. Then, start playing your record. It is suggested to let the entire side of the record play even if there are multiple tracks. When you are done recording the tracks you want, press the Stop button. The Editor screen will now display the audio waveform.
EDITING THE AUDIO

Now you are ready to trim any unwanted audio (such as the silence between songs). Trimming will also separate the songs to create new "Clips". It is easy to see the separation between songs. This is where the volume of the waveform is at a low-level. If there is only a short space between songs, then it might not be quite as easy to see. The screen below shows the relative area where the tracks change.
6. To make it easier to split up tracks or delete unwanted silence between songs, left-click the mouse and drag it over the areas between the songs. Press the (6) Zoom Selection button and the screen now zooms into the area between the songs.

7. You can place the playback cursor at the start of each song and then press the (7) Split button to create a new Clip, or you can use the mouse highlight a larger area to delete unwanted silence, and then press Delete on your keyboard. This will delete the unwanted audio and create a new Clip. Continue doing this for each song to create new Clips. You can also delete the audio at the start of the record and at the end. Now you’re ready to create Markers that will be used to define Clips as CD or MP3 tracks.

8. There are two ways to create Markers. The first is to place the Playback cursor at the start of each Clip and press the (8) Insert Marker button. You can also automatically create Markers at the start of each Clip. Under the Edit Menu, select the “Insert Markers at Clip Start”. This will create markers for every Clip.
The next step is to name the Markers with the song names. Markers are indicated with a triangle.

Place the cursor over a Marker and right-click the mouse. That displays the Maker naming window.

Enter the name of the song and press OK. Continue doing this for each Marker. Now you are ready to process the audio.

PROCESSING CLIPS
Audio Creator LE allows you to process your audio clips. The two most common processing functions are Normalizing and Audio Restore. Normalizing raises the level of your audio clip to a maximum user-defined level that will make the Clip louder on playback. Audio Restore is used to remove pops and clicks and eliminate background noise.

Normalizing a Clip
Normalizing a Clip raises its audio level to maximum loudness or close to that. The pictures below show a Clip before normalizing it and after normalizing it.
9. To normalize a Clip, first press the (9) Clip Select button. Then, place the cursor over a Clip and click to select it.

10. Next, press the (10) Normalize button. This brings up the Normalize window, as shown below.
It is usually best not to normalize to 100%. Instead, choose -0.5 dB or -1 dB. Set the normalization level to your desired amount and then press OK.

**Using the Audio Restore Plug-in**

Audio Creator LE includes an audio plug-in that helps eliminate noise, clicks and pops from a record. The plug-in is called Audio Restore by iZotope.

To select the Audio Restore Plug-in from Cakewalk, right-click on the clip you wish to process. Then, select Process Clip Effect, then Cakewalk, and then Audio Restore. This will look like the picture below:

This will display the Audio Restore window.
In this window, you can select the following options:

- DeNoiser - This will help eliminate record background noise.
- Declipper - This will eliminate parts of the audio where clipping occurs. Clipping happens when the recorded audio exceeds maximum level.
- DeClicker - This will remove clicks or pops from the audio file.

It is best to try the default settings first. The Train button is useful for “training” the Audio Restore plug-in to recognize what you consider background noise. Make your settings and press OK. If the result is not what you were expecting, you can select Undo (Control-Z) and try different settings. In the example below, there was a click in the audio from the record. Audio Restore removed the click.

Creating Audio CD’s
Creating an Audio CD will allow you to playback your recording on any standard CD player. Unlike data CDs, audio CDs do not allow you to fit as many songs on the disc but ensure compatibility with older CD players.

1) After you have edited and processed the audio, you are ready to create an Audio CD. First, make sure no Clips are selected. To do this, Press the Select Time button (to the right of the Select Clip button). Then, click anywhere in the edit window to de-select a clip.

2) Under the File menu, select Save As, then choose the WAV option. This will display the following window:
3) Click the “Use Markers as Track Indicators” checkbox to select it. This will automatically save each track and give it the same name as the Markers that you named.

4) Then, click the “Add to Audio CD Track List” checkbox. This will automatically add all the tracks to the CD track list, making it easy to make a CD after saving the tracks.

5) Press the Save button, and all your tracks will be saved with the correct names.

6) Bring the Audio Creator Toolbar to the front and click on the BURNER button. This brings up the window below:

7) The CD tracks will already be in the list. You can add more tracks by pressing the Add Tracks button. Press the OPTIONS button to set the speed for CD burning. Finally, press the BURN CD button and your audio CD will be created.

Creating MP3 CD’s

MP3 CD’s are useful for CD players that support reading data CD’s as opposed to audio CD’s. By burning a CD with MP3s you can fit significantly more songs on the disc, but risk not being able to play the CD back in older CD players.

1) If you want to save your audio clips as MP3 files, under the File menu select Save As and then choose MP3. This brings up the following screen:
2) Click the “Use Markers as Track Indicators” checkbox to select it. This will automatically save each track as an MP3 file and give it the same name as the Markers that you named. Press the Save button, and the following screen is displayed.

3) First, select the bit rate for the MP3 files. Higher bit rates yield better quality. Set the Stereo Mode to Stereo. Variable Bit Rate Encoding sometimes yields better results, but may not be good if you are posting the files on the internet. The High-Pass Filter and Low-Pass Filter remove the highest and lowest frequencies. For best audio quality, do not select these features. The Quality slider determines how in-depth the MP3 encoder examines the file prior to encoding.

The ID3 Info section allows you to write information about the MP3 tracks. If you have selected the Markers as Track Indicators feature, then the saved file name will be the same as the Track marker name. You can add in the name of the band, the album name, song title and other information here. That information will be written for all the saved tracks. Press the OK button to save the files. As each clip is saved, this dialog box appears so that ID3 tags can be changed if you wish. Now are you are ready to create an MP3 CD.

After you have written the MP3 files, the TAGGER module on the Audio Creator Toolbar can be used to edit tags.

4) To create an MP3 CD, bring the Audio Creator Toolbar to the front and click on the BURNER button. Select the Data CD Burner tab. It brings up the following window:
Press the Add File button to select the MP3 tracks you wish to write to CD. If you have files for one artist placed in a folder, press the Add Folder button to add an entire folder. When you have all the MP3 tracks selected, press the BURN CD button and the CD will be created.

Congratulations! You have successfully digitized your 1st vinyl record! Feel free to experiment with the other features of Pyro Audio Creator LE. The online Help screens offer help about the various functions. You can find further help for all Stanton products online. The Stanton FAQ can be found at:

http://www.stantondj.com/v2/spt_faq.asp

The Stanton Knowledge Base can be found at:
http://www.stantondj.com/activekb/
GENERAL

Model: T.92 USB
Dimensions: 452(W) x 370(D) x 143(H)mm
Weight: 8.6Kgs

Power supply:
- AC 100V, 50/60Hz (For Japan)
- AC 110V, 60Hz (For Taiwan)
- AC 120V, 60Hz (For U.S.A., Canada, Mexico)
- AC 220V, 50Hz (For United Arab Emirates, Chile, Argentina)
- AC 220V, 60Hz (For Philippines)
- AC 230V, 50Hz (For Europe, New Zealand, South Africa, Singapore, Israel)
- AC 240V, 50Hz (For Australia, U.K.)

Power consumption: 11W

STANDARD TEST CONDITION:
Ambient Temperature 20 +/- 2 deg. C
Relative Humidity 65% +/- 5%

NOTE: Measurements can be carried out between 5 deg. C to 35 deg. C and 45% to 85% relative humidity.

TURNTABLE SECTION:
Type 3-speed full manual
Motor 8pole, 3phase, brushless DC motor
Speeds 33 1/3 and 45rpm and 78rpm
Wow and Flutter Less than 0.15% WRMS (JIS WTD) with 33 1/3 rpm
S/N Ratio More than 50dB (DIN-B)
Pitch Controls +/- 8%, +/-12%
Starting Torque More than 1.6kgf.cm
Starting Time Less than 1 sec. with 33 1/3 rpm
Braking Time Less than 1 sec. with 33 1/3 rpm
Braking System Electronic brake
Time for Speed Change Less than 1 sec. from 33 1/3 to 45 rpm
Less than 1 sec. from 45 to 33 1/3 rpm
Less than 1 sec. from 33 1/3 to 78 rpm

USB Function USB rec. Function
A/D,D/A 16BIT 44.1KHz or 48KHz USB SELECTABLE
Computer interface: USB 1.1compliant, WINDOWS XP, WINDOWS VISTA and MAC OSX

TONEARM SECTION:
Type Static balanced S-shaped tonearm with detachable headshell
Effective Arm Length 230.5mm
Overhang 16mm
Applicable Cartridge Weight 5.5g
Tracking Error Angle Less than 3 degree
Tracking Force Adjustment Range 3-4g
Anti-skating Range 0-7g
Needle Pressure range 2-5g

AUDIO SECTION:
Digital Digital Output 0.5Vp-p +/-20% (LOAD 75 Ω)
Phono Phono Output 2.5~5.0 mV at 1KHz 5cm/sec (HP-4005)
Frequency Response 20Hz-20KHz +1/-3dB
Channel Separation More than 14dB
Channel Balance Within 2.5dB at 1KHz
Line Line Output 36.8~73.5 mV at 1KHz 5cm/sec (HP-4005)
Frequency Response 20Hz-20KHz/RIAA filter +1/-3dB
WARRANTY & RETURN POLICY

Warranty
Through Stanton’s authorized dealers around the World, Stanton, or one of Stanton’s authorized distributors outside the U.S., will, without charge, repair or replace, at the sole discretion of the entity responsible for making the repair or providing the replacement, any Stanton merchandise proved defective in material or workmanship for a period of one year following the date of original purchase. Exceptions to this warranty are as noted below:

The warranty for mechanical parts which are subject to wear and tear are limited to the earlier to occur of thirty (30) days following the date of original purchase or the following number of cycles: Faders - 15,000; Rotary potentiometers - 10,000; and Switches - 10,000.

Stanton will warrant all replacement parts and repairs for ninety (90) days from the date of original shipment. Repairs made necessary by reason of misuse, alteration, normal wear, or accident are not covered under this warranty.

Returns
Authorized Stanton dealers are only authorized to sell and distribute merchandise within a specific country. All goods requiring warranty repair or replacement must be returned (freight prepaid if not hand-delivered) to the authorized Stanton dealer from whom the merchandise was purchased and in the same country where the merchandise was purchased. For purposes of purchases made via the Internet, the merchandise must be returned to the authorized Stanton dealer in the country where the authorized Stanton dealer which sold the merchandise to purchaser is located and not the authorized Stanton dealer in the country where the purchaser is located or the country in which the merchandise was received. Any returns to a non-authorized dealer or to an authorized Stanton dealer not in the same country as the merchandise was intended to be sold or as set forth above will void this warranty.

To initiate a warranty repair, you must contact the authorized Stanton dealer from whom you purchased the merchandise, and follow such authorized Stanton dealer’s return policy.

Stanton assumes no risk and shall be subject to no liability for damages or loss resulting from the specific use or application made of the merchandise. Stanton’s liability for any claim, whether based on breach of contract, negligence, infringement of any rights of any party, or product liability, and relating to the merchandise shall not exceed the price received by Stanton from your purchase of such merchandise. In no event will Stanton be liable for any special, incidental or consequential damages (including loss of use, loss of profit and claims of third parties) however caused, whether by the negligence of Stanton or otherwise. To the extent permitted by law and except as otherwise provided above, Stanton disclaims any express or implied warranties of merchantability or fitness for a particular purpose.

The above warranty provides you with specific legal rights. You may also have additional rights, which are subject to variation from state to state and country to country.

If there is a dispute regarding the warranty of merchandise that does not fall under the warranty conditions stated above, please include a written explanation with the merchandise when returned pursuant to the terms and conditions set forth herein.

Please register your product online at www.stantondj.com.

Stanton Magnetics • 3000 SW 42nd Street • Hollywood FL 33312

Phone: +1 954.316.1500

Technical Support:
service@stantonmagnetics.com